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7  Revising with Word Processing/
Technology/Document Design

Douglas Eyman and Colleen Reilly

Innovations in technology have historically provoked profound chang-
es in literacy acquisition and expression. From the development of the 
written alphabet to the printing press, changes in technology affect the 
way we think, write, and communicate and, by extension, the way we 
teach written communication. The personal computer as writing tool 
is now as ubiquitous as the printed page, and like advances in writing 
technology before it, the computer has affected the process of writ-
ing at every stage, from invention, through revision, to delivery. This 
chapter begins with a brief history of computers and revision and then 
examines the potential impact on revision practices and strategies of 
both computer technologies and the recent expansion of composition 
to include multimodal processes and productions. Throughout the 
chapter, we provide concrete suggestions for using available computer 
technologies to encourage substantive revision, while demonstrating 
the need for informed and critical instruction in concert with the use 
of technologies to affect changes in students’ perspectives on and em-
ployment of revision in their writing processes.

Scholarship about Computer Applications and Revision

Since the introduction of computers into writing classrooms, scholars 
have questioned whether computer applications positively affect stu-
dents’ writing and writing processes. Some of the issues raised include 
the degree to which computer applications prompt students to write 
more and engage in substantive revision given that these applications, 
such as word processing software, seem to make revision easier. One 
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of the first major studies of word processing and revision was Colette 
Diaute’s 1983 “The Computer as Stylus and Audience,” which argued 
that student writers would revise more easily and more quickly than 
they would with traditional pen and paper writing technologies; simi-
lar studies stressed the inherent freedom and flexibility of composing 
on-screen as important factors in revision practices (Bean; Marcus; 
Sudol). However, subsequent work suggested that student writers 
(as opposed to experienced writers) performed fewer revision activi-
ties on-screen than they would have on paper (Collier; Harris,1985; 
Hawisher; Lutz). It has been suggested that the differences are a func-
tion of access and experience with composing on the computer (Tone 
and Winston; Owston, Murphy, and Wideman)—thus studies done 
in the 1980s and 90s may not be as reliable as similar studies that 
have been published more recently, which reflect the current situa-
tion regarding student access and experience. A 2003 meta-analysis 
of research about the effects of word processing on student writing 
indicated that all of the studies that were published between 1992 and 
2002 found that students using computers did make more changes to 
their writing than did students using pencil or pen and paper (Cook, 
Goldberg and Russell 4).

One strain of recent research indicates that revising on the com-
puter screen with word processing applications can impede revision. 
Several studies (Crafton; Hill, Wallace and Haas; Klonoski; Tone and 
Winchester; Yagelski) have noted that students’ reliance on spell check 
and grammar check applications often lead to a focus on surface error 
correction at the expense of substantive revision. Additionally, Crafton 
notes that the user-friendly and transparent appearance of the inter-
face blocks critical analysis of how it determines/controls the writing 
process: “User-friendly point-and-click software may actually disguise 
the ways the medium acts as a metaphor. We cannot see how technol-
ogy conditions the expression or how it operates as a model, a cognitive 
structure, that organizes our thinking” (319). Furthermore, Crafton 
argues that for basic writers in particular, using computer technologies 
for writing adds an additional layer of complexity to the already com-
plicated process of composition. Hill, Wallace and Haas agree that 
revising on the screen encourages localized, sentence level rather than 
global revision, but attribute this as much to inadequate task defini-
tion of revision as to the tools used to accomplish it (105; see also Ya-
gelski).
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Another potential barrier to revision is the small window provided 
by the space on the screen: Daniel Kies suggests to his students that 
the “screen is just too small a canvas for us to get a sense of our draft 
as a whole. So printing a draft, often and regularly, is the only way to 
truly see the work holistically. A printout will allow us to better see 
the connections between the major parts of our work and to judge the 
work’s unity and coherence.”

While the aforementioned research certainly has merit and requires 
our attention, we agree most strongly with the perspective that empha-
sizes the importance of thoughtful, conscious, and critical instruction 
in assisting students to use computers and computer applications to 
foster global and substantive revision. For example, in a study of 12th 
grade writers that found students focusing on surface error, Yagelski 
noted that “the students’ revision choices were strongly influenced 
by the teacher’s retaining all authority for determining what consti-
tutes ‘good’ writing and by her emphasizing correctness as its most 
important criterion” (216). Other studies have shown that instructor 
feedback and writing prompts have a greater effect on the depth of 
revision than the technology employed (Reynolds and Bonk; Tuzi). In 
the remainder of this piece, we demonstrate how in combination with 
thoughtful and critical instruction that encourages reflection, writing 
teachers can use a range of computer applications from word proces-
sors to Web design applications to help students develop more substan-
tive revision processes and improve their writing.

Basic Computer Applications and Revision Strategies

In a study of the effects of oral and online discussion and its impact 
on revision, Beth Hewett notes that “revision changes revealed dif-
ferent qualities when developed in different environments, suggesting 
that medium shapes revision” (217). We would further suggest that 
the tools available in a given medium offer particular affordances for 
revision practices; in this section, we address the different practices 
facilitated by the tools that are available in word processing programs 
that are widely available in most computer classrooms and campus 
computer labs. We demonstrate how thoughtful instruction in the 
use of these basic tools can facilitate the types of revision we would 
like to encourage. Some of the examples specifically reference features 
of Microsoft Word ™; however, most of the tools discussed below are 
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available in most of the text processing programs that students are 
currently using, including Corel WordPerfect™ and open-source ap-
plications such as OpenOffice.

Cut and Paste

One of the key features of word-processing applications is the ability 
to select text of any length (word, sentence, paragraph, page), remove 
it from its current location in a document, and place it in another loca-
tion. Many early adopters of word-processing applications in writing 
classes pointed to this feature as an indicator of the possibilities for 
deep revision as opposed to surface revision because the actual work 
of moving text had become both simple and immediate. Simple revi-
sion exercises can be accomplished using only this basic feature. For 
instance, Nick Carbone suggests the following exercise for emphasiz-
ing the possibilities of deep revision using cut-and-paste: students can 
cut the concluding paragraph from a draft, copy it, put it in a new 
window, and then write a new draft with that final paragraph serving 
as the first. If the student’s final paragraph merely repeats what is their 
current first paragraph, (an instance that highlights the need for revi-
sion of the introduction or conclusion or both), the same exercise can 
be performed using a paragraph from the middle of the draft. This 
exercise encourages students to think in terms of global revision prac-
tices and helps them to see the possibilities of large-scale revision—in 
this case, cut-and-paste is a practice not simply for moving smaller 
elements within a text, but is a vehicle for radical revision involving 
the composition of a new but related text. Furthermore, this exercise, 
particularly if they draw on text from the first draft to compose the 
second, can demonstrate to students how the process of writing can 
advance their thinking on a topic by showing them that if they begin 
the new paper at their conclusion, which represents the culmination of 
their thought process, they may produce a text with more depth and 
complexity, having worked out some of the issues through the initial 
writing process.

Font Formatting

Font formatting is another basic component of all word-processing 
applications, but it can be used to encourage students to see the ele-
ments of their writing style via visual markers (a practice that has been 
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shown to work particularly well with basic and ESL writers). An in-
structor can ask students to change active verbs to boldface, highlight 
passive constructions in italics, use larger fonts for descriptive words, 
underline the thesis statement, or select particular font colors for topic 
sentences in each paragraph. This kind of visual marking presents a 
striking image of the text and can show the writer elements that may 
be overused or missing. Obviously, this sort of exercise requires in-
struction in identifying these constructions within a text, which may 
also help students gain control of their prose by providing them with 
the tools needed to analyze and discuss it.

Textual Analysis Tools

Most word-processing programs offer automated tools that attempt 
to analyze and provide data about a text’s organization, style, gram-
mar and spelling. While these tools can be used to support revision 
strategies, they require a great deal of instruction and scaffolding in 
order to be used effectively. Heilker notes that students often interpret 
suggestions from these automated tools, such as the grammar checker, 
as having a degree of authority equal to that of a human instructor, 
resulting in a displacement of the writer-audience relationship to a 
writer-computer relationship in the rhetorical situation (65). Although 
most of these automated analysis tools emphasize sentence-level con-
structions, Microsoft Word also provides an AutoSummarize tool that 
can be helpful when considering revisions of a text’s organization: the 
application examines the document, selects topic and thesis statements, 
and may either highlight those elements within the document, place 
the summary in a new document, or place an “executive summary” at 
the beginning of the current document. The summaries and outlines 
produced by this tool can help students to visualize the organization 
of their text and show them how it may potentially be viewed by an 
outside observer.

Many word-processing applications will also produce simple sta-
tistics about the current document (often incorporated into the gram-
mar-checking feature). The statistics include counts of the numbers 
of words, sentences, and paragraphs, as well as the average number 
of words in sentences and sentences in paragraphs. Microsoft Word 
also provides the percentage of sentences that are in the passive voice. 
Checking these statistics can be a useful revision tool if employed 
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critically: if students tend to write short, choppy sentences (or long, 
wordy sentences) the tool helps them to note the average number of 
words per sentence in their documents. Similarly, a student can check 
the percentage of passive sentences in the document in order to as-
sess whether or not they unknowingly and unconsciously tend to use 
passive constructions. Like grammar and spell checking components 
(which tend to emphasize surface-error correction), this and other au-
tomated analysis tools should be used along with instruction and re-
flection concerning the writing practices and values that they support. 
For example, the passive voice can be used very effectively and strate-
gically to downplay agency and avoid placing blame. Students should 
be asked to discuss why the passive voice is flagged as an error by the 
software, examine the types of writing that the absence of the passive 
voice encourages, note rhetorical situations in which it is or is not the 
most appropriate choice.

Track Changes

The Track Changes feature in Microsoft Word is accessible from the 
Reviewing toolbar (View > Toolbars > Reviewing). Accessible from the 
Reviewing toolbar are several options: users can turn Track Changes on 
or off, choose which changes to show, move through changes to reject 
or accept them, and add balloon comments. With the Track Changes 
feature enabled, the writer or reviewer can insert recommendations 
directly into a text (which is more intrusive than using the comment-
ing feature, but which allows an instructor to make suggestions for 
revision so that the student can see a model of how that instructor ex-
pects him or her to approach the process of revision). Accept or Reject 
Changes allows the writer to accept a correction (thus making it part 
of the revised document) or to reject a suggestion. This is particularly 
useful when using the Track Changes feature as part of a peer-review 
or collaboration process. From the Tools menu, user can Compare 
and Merge Documents, which allows the student and/or instructor to 
quickly see the changes that have been made between revisions while 
keeping discrete copies of the work performed thus far intact; this 
could be useful for developing and grading portfolios in which success 
is measured to some degree in terms of the types and depth of revisions 
completed. Such comparisons provide a striking visual representation 
of the alterations made to a text.
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The Track Changes feature in Microsoft Word can be used to help 
students to see and reflect upon their revision process and prompt 
them to move from less to more substantive, global revision. In order 
for the results of this feature to be useful, however, students need to 
be taught to use it consistently and correctly, otherwise the results will 
be meaningless and inaccurate. Implementation of the Track Changes 
feature in the writing process requires a strong schedule of due dates 
during the drafting and then revision process, clear instructions for 
students to follow (see Appendix A), and instructor oversight. As with 
all technologies, for this feature to encourage students to reflect on 
and alter their revision processes, its use must become a natural part of 
the writing process, be consistently required, and be commented upon 
constructively for it to make a difference.

In composition classes, students can be asked to use the Track 
Changes feature at various points in the writing process, from inven-
tion to the revision of drafts. During the revision process, it may be 
best to designate a specific date for the end of drafting and the start 
of revision, although this point may be largely artificial. Students can 
turn on the Track Changes feature as of this date and the alterations 
that they make to their texts in each subsequent composing session, 
however brief, will be recorded. The highlighted changes can then 
be used to help students become aware of the types of revisions they 
make, use that awareness to alter their processes and explore revision 
on more than one level, and help them to receive comments from their 
instructors regarding the types of revision in which they engage. The 
first time students track their changes, they may be surprised to learn 
that most of their revisions are sentence level and localized. This recog-
nition—again resulting from visual cues—can prompt some students 
to attempt to engage in more global and perhaps significant revisions, 
such as adding and deleting content and restructuring across sections. 
The use of this feature is even more significant if students are asked to 
reflect on their experiences and brainstorm changes that they might 
make to their revision practices in light of what they observe. Addi-
tionally, instructor feedback on the drafts showing the revisions helps 
to reinforce the importance of focusing on revision and making the 
process as productive and substantive as possible.

Moreover, students can be taught to use the Track Changes fea-
ture to assist in the development and revision of collaborative projects. 
When working on a text collaboratively, each student can add their 
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changes in a particular color using the Track Changes feature, thus 
highlighting the contributions of each group member. This can be 
helpful in encouraging equal participation and differentiating various 
versions of the text from one another. Such use of this feature requires 
the instructor to help students coordinate the addition of changes and 
the acceptance or rejection of the additions made by their peers. Stu-
dents need to be taught to both add and then negotiate the changes 
made by others when composing and revising texts. Without establish-
ing a clear and systematic process for incorporating this feature into 
their writing process, its use can cause more confusion and simply in-
troduce more work into the collaborative writing process.

Highlighting and Commenting

Both highlighting and commenting can also be helpful in the revi-
sion of collaborative projects and in the process of peer review. Word’s 
highlighting tool allows a student or peer-editor to accent text in a 
range of colors, creating a system in which different colors indicate 
various types of content, grammar, and spelling errors. Because revi-
sion is a recursive process that occurs within all of the stages of draft-
ing (particularly when that drafting is completed via a word-processing 
application), highlighting can also be very useful for marking places in 
a text that may need to be revisited or reassessed during the composing 
process. For instance, in the initial draft of this chapter, this section 
contained a sentence fragment that might have been left incomplete 
had it not been highlighted during the drafting process. Highlighting 
can be very useful in the peer-review process, as the writer can visually 
mark the passages or elements that he or she would most like feedback 
on. Additionally, in creating a collaborative text, peers can highlight 
the sections of a draft that are unclear or need attention, and these sec-
tions can receive more attention during group writing sessions.

The commenting feature can also be useful in peer review, col-
laborative writing, and receiving comments from an instructor. There 
are two kinds of commenting tools available in most word-processing 
applications: in-text commenting (using a different font color for each 
commentator), and annotations that appear in the margins or as pop-
ups and are indicated by highlighting that appears on a word or phrase. 
The annotations feature is less intrusive and using that type of com-
ment mitigates the feeling of violence done to a student text, particu-
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larly since the annotations—even if they appear in the margins—can 
be hidden with the click of a mouse on the appropriate menu selection. 
If the student and instructor have access to sound capabilities it is pos-
sible to also add audio commentary to a draft, but the file size expands 
very rapidly with the addition of audio comments.

When working collaboratively, rather than making changes di-
rectly in the text, students can make suggestions for changes or ask 
for clarifications by adding annotations using the comment feature. 
Additionally, commenting can be used in conjunction with the Track 
Changes feature to explain why particular changes were made or to 
request that peers examine a particular section of the revised text 
carefully and approve it. In revising this chapter, we used both Track 
Changes and commenting to communicate about the alterations that 
each of us made to the initial draft; these features proved indispensable 
to our long-distance writing process.

Other Applications for Peer Review

Besides using the features of word processors discussed above, peer re-
view, an important part of the revision process in many writing classes, 
can also be facilitated by the use any number of online peer review ap-
plications (Hewett; Tuzi). Online peer review allows students to con-
tinue working with peers and mentors outside of the classroom and the 
comments of peers can be easily recorded and accessed by instructors 
and by the class as a whole so that the peer review process can be ex-
amined, assessed, and improved.

In the traditional classroom, peer review typically involves ex-
changing papers, commenting on drafts, and meeting to exchange 
direct feedback and engage in talk-aloud protocols. Using network 
technologies allows us to teach students new modes of collaboration 
that not only streamline the peer-review process, but also offer pri-
vate partnerships (using email), semi-public group work (using course 
management systems or discussion boards available only to the group 
or class), or a completely public process (using Web sites).

Electronic peer-review can be used both inside and outside the 
classroom: students can work together in person on a document on 
one terminal and revise collaboratively or switch seats in a comput-
er classroom, thus allowing peers to work directly with each other’s 
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drafts. Nick Carbone advocates collaborative revision as a form of elec-
tronic review:

Have students copy just the first and last paragraphs from an essay 
into a new file. Have them swap files and fill in a classmate’s essay—
in other words, based on the first and last paragraph, what do they 
think the argument is and what will the essay say? Or, have them post 
their first and last paragraphs in a discussion area, and then they can 
talk online with one another about what they expect to see and why 
(n.p.).

Online peer-response may take the form of comments on drafts, 
responses to drafts, or discussions about the writing process or about 
specific texts. Students can exchange documents in class for a close 
reading, have readers email comments to writers, and then continue 
the discussion or talk-aloud reviews begun in class on a group dis-
cussion list, where students can post work and receive feedback from 
multiple peers. Commenting on sentence level issues proves to be more 
difficult if the text is posted online and cannot be written on. Thus, 
Web-based discussion lists privilege a different kind of peer critique 
and students can be prompted answer questions about the organiza-
tion and the validity of the ideas expressed in their peers’ texts rather 
than the surface errors that they may see.

Online, Web-based peer review applications also provide a space 
where each student in the class can upload their text and review de-
tailed comments from one or more members of the class. Generally, 
such applications allow instructors to develop a list of questions for 
students to answer about the drafts of their peers; the answers to these 
questions are posted on the webspace as well and can be viewed by all 
students in the course. Additionally, most applications also allow for 
students to make specific comments about the content, style, or con-
ventions of particular paragraphs in the posted drafts and these com-
ments are attached to those places in the text. While posting drafts 
and peer comments on the Web poses privacy issues that should be 
discussed, the practice facilitates class discussion of peer review as a 
practice and allows instructors to easily review and comment on the 
process and intervene as needed. Additionally, the comments of mul-
tiple peers can be accessed by students both in class and wherever they 
have access to the Web. Of course, the use of such applications proves 
to be most beneficial if accompanied by class discussions on how to 
write constructive comments and maximize the features of the online 
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application and how to respond to and distill the comments of mul-
tiple peers and translate their suggestions into revisions.

Remediation, Redesign, and Revision

Teaching new media composition provides other opportunities to use 
computer technologies in ways that help students view and apply revi-
sion strategies that result in substantive changes in both the form and 
content of their texts. In the most basic sense of the word, remediation 
(as defined by Bolter and Grusin, 28) of print texts, such as essays and 
research papers, into other media has the potential to encourage deep 
revision by prompting students to rethink the purposes, audiences, 
and structures of their original texts. When composing a traditional 
course paper, students may be told to imagine specific audiences and/
or purposes for their writing, but those imagined audiences are largely 
superficial; the instructor is often perceived as the final, primary audi-
ence. Additionally, as noted above, students have difficulty separat-
ing revision and editing and often make only superficial changes even 
after being taught how to revise. However, introducing students to 
new communication media accompanied by new environments and 
contexts for their writing may alter the situation sufficiently to require 
students to rethink their content and formatting choices and make 
significant changes or risk composing texts that are inappropriate for 
new contexts.

One way to use technologies to prompt revision is to have stu-
dents remediate print texts by asking them to create a presentation 
supported by PowerPoint slides based on a paper they have written; 
in order to complete this activity, their audiences, purposes, and sub-
stance of their material must change based on the new context for their 
work. A change in media from largely textual to visual/textual/oral re-
quires altering and adding to the information. Writing a presentation 
of material for a classroom audience, for example, requires students to 
consider the aspects of their information that would be most under-
standable and interesting to their peers. Additionally, they may have 
to define terms and concepts that they did not feel they had to define 
for their instructor. PowerPoint is also an interesting technology to use 
when revising the structure and organization of a text. PowerPoint en-
courages a linear, hierarchical structure that may help students see the 
ways that their own texts do not fit this pattern and also may reveal 
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to them the limitations of such an organizational pattern, demonstrat-
ing that organization as well as content and other aspects of the text 
should be consciously chosen and are open to revision. Finally, be-
cause PowerPoint is a visual medium, students can be prompted to do 
more research to find visual elements, including a layout and design as 
well as graphics, to supplement their textual information. This act of 
extending research into the revision process is commonly overlooked 
when revising academic print texts. While looking for supplementa-
ry visuals to create presentations, students may find other informa-
tion that may add a new dimension or element to their previous texts, 
prompting them to view the subject or issue in a new light. This fresh 
look at their subject matter resulting from the additional research and 
refocusing of the print text for a presentation format can help students 
to see the usefulness of other types of revising activities. Remediation, 
if done thoughtfully, requires students to dismantle and reassemble 
texts with a new focus and for a new audience, creating a space where 
substantive revision may occur.

Other media such as MOOs, websites, and digital video can also 
be employed to prompt a reconsideration of revision and help students 
to see the limitations of their typical print-based composing processes. 
Thus remediation can promote revisioning not only the texts but the 
process by which composition is done. When developing a website, for 
instance, students may focus on the layout and visual design features 
separately from the content, acknowledging the rhetorical aspects of 
design and the importance of considering the effects of design ele-
ments on textual arguments. In contrast, in a print piece, content is 
all and format is often not considered or only thought of minimally in 
order to conform with instructor-imposed standards of layout or style 
largely because such linear academic texts are presented “as though 
there is nothing visually rhetorical in them” (Wysocki 182). Further-
more, the content included on a website needs to be shaped in order 
to be suitable for online reading, easy navigation, and visual appeal. 
Because websites have links to other related sites, in order to create an 
effective site, students need to do research online to find other texts to 
which theirs can be connected. Such research and linking helps stu-
dents to become more aware of the context, at least online, in which 
their texts are located, which may help them to better situate their ar-
guments and position them vis-à-vis those of others.
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In order for students to benefit from remediating print texts in 
other media and prompt a long term intervention in their composi-
tion processes, they need to be asked to reflect on their remediated 
texts and their development processes and locate points of departure 
from their typical workflow when writing with new media. As with 
other technologies employed in writing, simply using them is insuffi-
cient; the students have to become conscious and critical users through 
group discussion and individual reflection. Asking students to reshape 
texts for other media can highlight the contextual nature of the essay 
and other unquestioned hegemonic modes of writing ubiquitous in 
the academy. Analyzing what must be added, deleted, and reshaped 
to make the academic essay appropriate for other media dominant in 
other contexts, such as workplaces, shows the situational aspects of 
the essay while revealing its limitations as a genre as well as the values 
it reflects, which are often unexamined (Wysocki 182). In a reflec-
tive piece, which could be structured as an essay, website, video or 
even audio text, students can be asked to discuss the changes that they 
needed to make to their print piece for the new medium and examine 
the success or failure of those changes and of the new environment 
to convey their ideas, information, and arguments. Students can be 
asked to discuss in detail the changes that they made to the content 
and format of the piece, other changes that they now see they should 
have made, and the degree to which their remediation is successful in 
terms of offering a more complete, interesting, or effective representa-
tion of their ideas.

Conclusion

Our discussion highlights many ways that computer technologies can 
be used to help students to rethink their revision practices and develop 
more substantive strategies for future revisions. As we demonstrate 
above, many computer technologies exist that can prove useful for re-
vision. Even simple applications, such as word processing programs, 
contain features with the potential to improve and facilitate individual 
and collaborative revisions. Throughout our discussion, however, we 
have highlighted the idea that the use of technologies is insufficient for 
helping students see and alter their composition practices. Instruction 
and conscious reflection on the part of teachers and students are need-
ed to make any technology—whether it is paper and scissors or the lat-
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est peer review application—a productive means for helping students 
to revise their work more globally and substantively.

Appendix: Directions for Using the Track 
Changes Tool in Microsoft Word

When you revise your papers/work for our class, please track the 
changes that you make for the following reasons:

• To allow you to reflect on your revision process

• To help you to make changes to and improve your revision pro-
cess

• To allow me to view and make suggestions concerning your 
revision process

After you complete a draft of a paper, you should turn the Track 
Changes feature on so that all the changes that you make to the paper 
are visible. When you submit the paper, submit it with the changes still 
visible. Do not erase or alter them.

Using the Track Changes Tool

1. Open your draft in Word

2. From under the Tools menu, select Track changes

3. Start making changes to your document. The changes you make 
will be recorded in the text on the screen.

4. When you are done making changes, save the document and 
close it as usual. Repeat this process each time you make revi-
sions to the initial draft of your text. Each time that you open 
your document, the changes from the previous work session 
will still be visible.

When you turn in your document, submit the version with all the 
changes in it. I can then view the document with and without the 
changes.

Customizing the Look of Your Changes

If you want your changes to appear in a different color or format, fol-
low these instructions for customizing them.
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1. Open your document in Word

2. From under the Tools menu, select Options and then Track 
Changes

4. Change the mark and color for each type of change that you 
want to alter.

5. Click OK. All subsequent changes will conform to your selec-
tions.




